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Sambutan Ketua Pelaksana 

 

 
Alhamdulillah, berkat rahmat Allah SWT, kita dapat berkumpul di Kampus 

Institut Teknologi Nasional Yogyakarta (ITNY) untuk mengikuti Seminar Nasional 

Rekayasa Teknologi Industri dan Informasi (ReTII) pada tanggal 9 November 2021. 

Tema yang diangkat dalam Seminar ini "Memberdayakan dan Mendorong Masa Depan 

Berkelanjutan: Peran Technopreneur dalam Ranah Penelitian di era New Normal“ 

Seminar Nasional ReTII ini merupakan kegiatan tahunan ITNY yang ke-16. 

Tujuan diselenggarakannya seminar ini adalah sebagai sarana untuk mempublikasikan 

artikel ilmiah, sebagai forum diskusi dan interaksi ilmiah antara akademisi, peneliti, 

praktisi dan pemerhati ilmu pengetahuan dan teknologi mengenai hasil-hasil penelitian 

maupun pengalaman teknis lainnya yang telah dicapai. Judul makalah yang akan 

dipresentasikan dalam seminar ini sejumlah 82 makalah. 

Panitia ucapkan terima kasih kepada yang terhormat Ibu Dr. Ratna Kartikasari, 

S.T., M.T. yang berkenan menjadi keynote-speech, para pemakalah yang berkenan 

mengirim makalahnya dan berkenan hadir serta peserta seminar dan semua pihak 

yang turut serta berpartisipasi aktif dalam penyelenggaraan seminar ini. 

Panitia telah berusaha maksimal untuk menyelenggarakan seminar sebaik 

mungkin, namun kami menyadari masih ada kekurangan dan kami mohon maaf atas 

kekurangan yang ada. Akhir kata kami ucapkan “ Selamat Berseminar”. 

 

 

    Yogyakarta, 9 November 2021                                            

Ketua Pelaksana Semnas ReTII Ke-16 

     

    ttd 

                                                                        Dr. Ir. Sugiarto Kadiman, MT. 
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Dalam Rangka  

Pembukaan Seminar Nasional 

Rekayasa Teknologi dan Informasi (ReTII) ke-16 

Yogyakarta, 9 November 2021 

 

 

 

Assalamu’alaikum wr.wb 

Salam sejahtera bagi kita semua 

 

Pertama-tama marilah kita panjatkan puji syukur kehadirat Allah SWT karena hanya 

dengan ridhoNya kita dapat berkumpul di sini dalam rangka Seminar ReTII ke-16 dalam 

keadaan sehat wal’afiat. Mudah-mudahan Allah SWT juga memberi kemudahan 

kepada panitia dalam menyelenggarakan seminar ini. Demikian juga kepada para 

peserta dalam mengikuti acara seminar ini. 

 

Seminar ReTII kali ini merupakan yang ke-16 dan merupakan agenda tahunan ITNY 

yang dimaksudkan agar dapat menjadi ajang temu para pakar, peneliti riset dan 

pendidik untuk saling tukar pengalaman, informasi, berdiskusi, memperluas wawasan 

dan untuk merespon perkembangan teknologi yang demikian pesat. Selain itu 

diharapkan adanya kerja sama dari para pakar, peneliti dan pendidik yang hadir 

sehingga menghasilkan penelitian bersama yang lebih berkualitas dan bersama-sama 

pula ikut memecahkan persoalan – persoalan teknologi untuk kemandirian bangsa. 

 

Semoga seminar ini dapat terselenggara dengan baik dan memenuhi harapan kita 

semua. Akhirnya saya ucapkan terima kasih kepada panitia dan semua pihak yang 

membantu sehingga acara Seminar ReTII ke-16 ini dapat terselenggara dengan baik. 

Jika ada yang kurang dalam penyelenggaraan seminar ini, kami mohon maaf yang 

sebesar-besarnya. 

 

Wassalamu’alaikum wr.wb. 
 

 

 Yogyakarta, 9 November 2021 

 Rektor 

 

 ttd 

 

 Dr. Ir. H. Ircham, M.T. 
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ABSTRAK  

Data Base Spasial kelurahan Baratajaya merupakan sebuah aplikasi sistem database online yang menyimpan 

dan mengolah data dan informasi geospasial penataan ruang dan tematik wilayah menjadi sebuah sarana 

publikasi yang lebih informatif, mudah dipahami dan mudah diakses oleh masyarakat luas serta menjadi 

instrument dalam proses berbagi pakai data. Proses perwujudan webgis database adalah proses evolusi yang 

terdiri dari beberapa tahap atau fase pengembangan. Pengembangan webgis ini akan berkelanjutan dan 

membutuhkan penyempurnaan sehingga perlu upaya yang menerus dalam memperbarui serta 

mengembangkan aplikasi program berdasarkan teknologi kontemporer. Webgis Kelurahan Baratajawa 

merupakan WebGIS (Web-Geographic Information System) yang memiliki kemampuan untuk melakukan 

pengolahan data, menampilkan serta menganalisa data.Adapun tujuan yang ingin dicapai dalam kegiatan ini 

adalah Menyusun peta dasar Kelurahan Baratajaya dan perancangan webgis Kelurahan Baratajaya Kota 

Surabaya sehingga bisa diakses oleh semua kalangan dan pihak. Target dari temuan yang direncanakan 

adalah tersusunnya E- peta dasar merupakan WebGIS (Web-Geographic Information System) Kelurahan 

Baratajaya Kota Surabaya yang memiliki kemampuan untuk melakukan pengolahan data, menampilkan serta 

menganalisa data. 

Kata kunci: Sistem Informasi, Webgis, Peta Dasar. 
 

ABSTRACT  

The Baratajaya Urban Spatial Data Base is an online database system application that stores and processes 

geospatial data and information on spatial planning and thematic areas into a publication that is more 

informative, easy to understand and easily accessible to the wider community as well as an instrument in the 

process of sharing data. The webgis database embodiment process is an evolutionary process consisting of 

several stages or phases of development. The development of this webgis will be continuous and requires 

improvement so that it requires continuous efforts in updating and developing program applications based 

on contemporary technology. The Webgis of Kelurahan Baratajawa is a WebGIS (Web-Geographic 

Information System) that has the ability to perform data processing, display and analyze data. all parties and 

parties. The target of the planned findings is the compilation of an E-base map which is a WebGIS (Web-

Geographic Information System) Baratajaya Village, Surabaya City which has the ability to perform data 

processing, display and analyze data. 

Keyword : information Systems, WebGis, Base Map 

 

1. PENDAHULUAN  

DataBase Spasial Kelurahan Baratajaya merupakan sebuah aplikasi sistem database online yang 

menyimpan dan mengolah data dan informasi geospasial penataan ruang dan tematik wilayah menjadi sebuah 

sarana publikasi yang lebih informatif, mudah dipahami dan mudah diakses oleh masyarakat luas serta 

menjadi instrument dalam proses berbagi pakai data. Proses perwujudan webgis database adalah proses 

evolusi yang terdiri dari beberapa tahap atau fase pengembangan. Pengembangan webgis ini akan 

berkelanjutan dan membutuhkan penyempurnaan sehingga perlu upaya yang menerus dalam memperbarui 

serta mengembangkan aplikasi program berdasarkan teknologi kontemporer. Webgis Kelurahan Baratajawa 

merupakan WebGIS (Web-Geographic Information System) yang memiliki kemampuan untuk melakukan 

pengolahan data, menampilkan serta menganalisa data.  

Kegiatan penyelenggaraan sosialisasi informasi akan lebih mudah dengan menggunakan WebGIS 

sebagai alat bantu pengumpulan data spasial dan analisanya, sehingga hakikat dalam penataan ruang dapat 

tercapai yaitu kegiatan penataan ruang secara geografis (spasial) yang dilakukan dengan tujuan pengelolaan 

wilayah menuju tingkat kesejahteraan masyarakat yang lebih baik. Penyusunan Aplikasi Website webgis 

termutakhir ini sangat berguna untuk merangkum, menganalisa dan menampilkan data spasial terbaru yang 

difungsionalkan untuk sosialisasi informasi. Aplikasi webgis memungkinkan untuk monitoring dan evaluasi 

kegiatan pembangunan guna mendukung pengambilan keputusan dalam proses pelaksanaan 
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2. METODE PENELITIAN  

Untuk mencapai hasil akhir dari Penyusunan Data Base Peta Tata Ruang ini, dibutuhkan metodologi 

pelaksanaan yang standar sehingga sasaran-sasaran yang diinginkan dapat tercapai. Secara umum tahapan-

tahapan yang dilakukan dalam Perancangan Webgis Peta Dasar Kelurahan Baratajaya Kota Surabaya baik 

yang berupa sistem informasi website maupun Sistem Informasi Geografis adalah studi literatur, 

pengumpulan data, perancangan aplikasi, konstruksi aplikasi, pengujian dan evaluasi aplikasi, dan 

pemeliharaan. 

a. Studi Literatur 

Studi literatur ini dilakukan untuk mempelajari buku-buku literatur dan informasi yang berhubungan 

dengan permasalahan Perancangan Webgis Peta Dasar Kelurahan Baratajaya Kota Surabaya. 

b. Pengumpulan Data 

Yaitu kegiatan mencari, dan menemukan bahan-bahan yang berkaitan dengan kegiatan Perancangan 

Webgis Peta Dasar Kelurahan Baratajaya Kota Surabaya yang bersumber baik dari instansi terkait 

maupun dari data sekunder yang diperoleh melalu internet. 

c. Verifikasi dan Validasi SIG yang ada di Kelurahan Baratajaya Kota Surabaya 

Verifikasi dan validasi tersebut akan difokuskan pada data makro melalui dokumen RTRW Kota 

Surabaya dan data mikro melalui Kelurahan Baratajaya. Proses verifikasi dan validasi akan dilakukan 

dengan mensinkronkan SIG dikedua dokumen tersebut. Selanjutnya, kegiatan di tahap ini dilanjutkan 

dengan pengecekan ke lapangan untuk melihat kesesuaian data yang ada pada hasil sinkronisasi. 

d. Perancangan Program 

Melakukan perencanaan dan perancangan program serta cara kerja dari aplikasi software yang akan 

dibuat pada kegiatan Perancangan Webgis Peta Dasar Kelurahan Baratajaya Kota Surabaya ini. 

e. Pembuatan Program 

Proses pengerjaan pemrograman dengan bahasa pemrograman yang dipergunakan melalui sistem Qgis 

f. Pengujian dan evaluasi Perangkat lunak 

Pada tahap ini akan dilakukan pengujian terhadap sistem keseluruhan serta penerapan algoritma dan 

melakukan analisa program keseluruhan serta melakukan evaluasi dan pembahasan dari hasil uji 

program yang telah dibuat melalui sistem Qgis. 

g. Pemeliharaan Webgis Peta Dasar Kelurahan Baratajaya Kota Surabaya 

Pada tahap ini dilakukan pemeliharaan aplikasi untuk memastikan tidak ada kesalahan yang terjadi, 

sehingga aplikasi dapat digunakan dengan baik melalui sistem Qgis 

 
Gambar 1 Contoh Hasil Webgis Dengan Qgis 

3. HASIL DAN ANALISIS  

Kota Surabaya merupakaan salah satu kota besar di Indonesia. Sebagai salah satu kota besar, 

Surabaya memiliki luas wilayah 326,36 km2 yang terletak di antara 112o 36 -112o 54 Bujur Timur dan 7o 21 

Lintang Selatan. Wilayah kota Surabaya berbatasan langsung dengan Selat Madura di sebelah Utara dan 

sebelah Timur, sedangkan di sebelah selatan berbatasan dengan kabupaten Sidoarjo dan di sebelah barat 

berbatasan dengan Kabupaten Gresik. 

Wilayah kota Surabaya pada umumnya merupakan dataran rendah dengan ketinggian tiga sampai 

enam meter di atas permukaan laut, kecuali di sebelah selatan memiliki ketinggian 25 sampai 50 meter di atas 

permukaan laut. Sebagai dataran rendah, suhu udara di Kota Surabaya berkisar antara 27,3oC sampai 30oC. 

Rata-rata suhu tertinggi terjadi Oktober, sedangkan rata-rata suhu terendah terjadi pada bulan Juli. 
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Wilayah kota Surabaya dibagi menjadi lima wilayah kerja pembantu, yaitu Surabaya Pusat, 

Surabaya Timur, Surabaya Barat, Surabaya Utara, dan Surabaya Selatan. Tiap wilayah terdiri dari beberapa 

kecamatan. Adapun daftar kecamatan dari tiap wilayah adalah sebagai berikut. 

a. Surabaya Pusat 

Wilayah ini terdiri dari kecamatan Tegalsari, Simokerto, Genteng, dan Bubutan 

b. Surabaya Timur 

Wilayah ini terdiri dari kecamatan Gubeng, Gunung Anyar, Sukolilo, Tambaksari, Mulyorejo, 

Rungkut, dan Tenggilis Mejoyo. 

c. Surabaya Barat 

Wilayah ini terdiri dari kecamatan Benowo, Pakal, Asem Rowo, Sukomanunggal, Tandes, 

Sambikerep, dan Lakarsantri. 

d. Surabaya Utara 

Wilayah ini terdiri dari kecamatan Bulak, Kenjeran, Semampir, Pabean Cantikan, dan Krembangan. 

e. Surabaya Selatan 

Wilayah ini terdiri dari kecamatan Wonokromo, Wonocolo, Wiyung, Karang Pilang, Jambangan, 

Gayungan, Dukuh Pakis, dan Sawahan. 

Secara topografi, sebagian besar wilayah Kota Surabaya merupakan dataran rendah dengan ketinggian 

3-6 meter di atas permukaan laut pada kemiringan kurang dari 3 persen. Wilayah barat Kota Surabaya 

memiliki kemiringan sebesar 12,77 persen dan sebelah selatan sebesar 6,52 persen. Kedua wilayah tersebut 

merupakan daerah perbukitan landai dengan ketinggian 25-50 meter di atas permukaan laut dan pada 

kemiringan 5-15 persen.  

Jenis batuan yang ada terdiri dari 4 jenis yang pada dasarnya merupakan tanah liat atau unit-unit pasir. 

Sedangkan jenis tanah, sebagian besar berupa tanah alluvial, selebihnya tanah dengan kadar kapur yang 

tinggi (daerah perbukitan). Sebagaimana daerah tropis lainnya, Surabaya mengenal 2 musim yaitu musim 

hujan dan kemarau. Curah hujan rata-rata 172 mm, dengan temperatur berkisar maksimum 30°C dan 

minimum 25°C. 

Secara geografis, Kota Surabaya terletak di hilir sebuah Daerah Aliran Sungai (DAS) Brantas yang 

bermuara di Selat Madura. Beberapa sungai besar yang berasal dari hulu mengalir melintasi Kota Surabaya, 

yaitu Kali Surabaya, Kali Mas, Kali Jagir, dan Kali Lamong. Sebagai daerah hilir, Kota Surabaya sehingga 

dengan sendirinya Kota Surabaya merupakan daerah limpahan debit air dari sungai yang melintas sehingga 

rawan banjir pada musim penghujan. Secara administrasi pemerintahan Kota Surabaya terdiri dari 31 

kecamatan, 154 kelurahan, 1368 Rukun Warga (RW) dan 9118 Rukun Tetangga (RT). Kota Surabaya adalah 

kota metropolitan kedua setelah Jakarta, Surabaya secara pola ruang perkembangannya terbagi menjadi: 

a. Area permukiman vertikal baik berupa rumah susun (sederhana) maupun apartemen atau 

kondominium tersebar di hampir seluruh penjuru Kota Surabaya, sedangkan area permukiman 

diarahkan berkembang ke arah barat, timur dan selatan kota.  

b. Area untuk kegiatan jasa dan perdagangan yang dipusatkan di kawasan pusat kota dan pusat-pusat sub 

kota dan unit pengembangan serta di kawasan yang ditetapkan menjadi kawasan strategis ekonomi 

antara lain di kawasan kaki Jembatan Suramadu dan kawasan Teluk Lamong;  

c. Area untuk kegiatan industri dan pergudangan terkonsentrasi di kawasan pesisir utara di kawasan 

sekitar Pelabuhan Tanjung Perak dan Terminal Multipurpose Teluk Lamong, dan kawasan selatan 

kota yang berbatasan dengan wilayah Kabupaten Gresik dan Sidoarjo;  

d. Wilayah pesisir khususnya ruang darat dimanfaatkan untuk berbagai fungsi antara lain permukiman 

nelayan, tambak garam dan ikan, pergudangan, militer, industri kapal, pelabuhan, wisata pesisir 

sampai dengan fungsi kawasan lindung di Pantai Timur Surabaya serta terdapat aksesibilitas berupa 

jalan dan jembatan yang menghubungkan Kota Surabaya dan Pulau Madura (Jembatan Suramadu) dan 

Jembatan Sukolilo Lor – THP Kenjeran yang membuka akses di kawasan sisi timur laut Kota 

Surabaya; 5. Wilayah Ruang laut Surabaya selain dimanfaatkan untuk kegiatan pelayaran baik 

interinsulair maupun internasional, juga dikembangkan untuk kegiatan penangkapan ikan tradisional, 

wisata pantai di Kenjeran dan sekitarnya dan kawasan lindung laut di sekitar  

e. Pantai Timur Surabaya. 

3.1.  Langkah Kerja Arcgis 

Sebelum melakukan tahapan pembuatan WebGis pada perangkat lunak Qgis, tahap yang dilakukan 

adalah penyiapan data dalam bentuk Shapefile (SHP) yang dilakukan pada perangkat lunak Bernama 

Arcmap. Data peta yang disiapkan adalah data peta dasar dari Kelurahan Baratajaya Kota Surabaya 

diantaranya adalah Data Penggunaan Lahan, Data Jaringan Jalan, Batas Administrasi Kelurahan, 

Permukiman dan sungai. Beberapa tahapan yang dikerjakan diantaranya adalah sebagai berikut: 
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A. Memasukkan data  

Buka ARcMap 10.3 → Klik Add Data → Piilih SHP “Jalan”, “Kelurahan_Baratajaya”, “Penggunaan 
Lahan”, “Permukiman”, “Sungai” (Data yang ingin dimasukkan) → Klik Add → Muncul Hasil 

 
Gambar 2 Add Data Jaringan Jalan Kelurahan Baratajaya 

 
Gambar 3 Add Data Batas Administrasi Kelurahan Baratajaya 

 
Gambar 4 Add Data Penggunaan Lahan Kelurahan Baratajaya 
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Gambar 5 Add Data Permukiman Kelurahan Baratajaya 

B. Pengaturan Tampilan Data 

Pada Layers → Pilih SHP → Klik Kanan → Pilih Properties → Muncul Layer → Pilih Symbology → 

Categories → Pada Value Field → “Remark_1”, “Hirarki_2” (Klasifikasi yang ingin ditampilkan) → 

Klik Add All Values → Apply → Pilih Warna → OK 

 

 
Gambar 6 Pemilihan Klasifikasi 

 
Gambar 7 Hasil Klasifikasi yang dipilih 
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Gambar 8 Pengaturan Warna, Model, Dan Bentuk Klasifikasi 

 
Gambar 9 Hasil Data Shapefile Kelurahan Baratajaya Kota Surabaya 

3.2.  Langkah Kerja WebGis 

Setelah dilakukannya penyiapan data maka tahapan selanjutnya adalah pelaksanaan pembuatan 

Webgis dengan perangkat lunak Qgis dan tahapan input data pada perangkat lunak Qgis yang dilakukan 

dengan beberapa tahapan sebagai berikut: 

a. QMS dan Googlemaps 

Buka Aplikasi QGIS → Klik Plugins → Manage and Install Plugins → Cari Plugin Qgis2web → 

Klik Install Plugin → Cari QuickMapSevices → Klik Install Plugin → Klik Web → Klik 

QuickMapServices → Search QMS → Search “GoogleMaps” → Add 

 
Gambar 10 Buka Aplikasi Qgis 
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Gambar 11 Pemilihan Tools Plugin 

 
Gambar 12 Qgis 2 Web 

 
Gambar 13 Pemilihan Tools Quick Map Services  

 
Gambar 14 Tools Search QMS 
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Gambar 15 Add Google Maps 

b. Data Shapefile 

Klik Folder Penyimpanan SHP → CTRL + A → Masukkan Semua SHP yang ada di dalam folder   

 
Gambar 16 Pemilihan Folder Lokasi Penyimpanan 

 
Gambar 17 Input Semua Data 

c. Pengaturan Tampilan  

Klik Data SHP→ Properties → Symbology → Categorized → Remark_1 → Classify → Change 

Color → Ok 
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Gambar 18 Tools Properties 

 
Gambar 19 Pemilihan Symbology pilih Categorized 

 
Gambar 20 Pilib Klasifikasi yang Ingin Ditampilkan 

 
Gambar 21 Pengaturan Tampilan Klasifikasi Penggunaan Lahan 
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d. Export Data 

Klik Tools Web → Klik Qgis2web → Create Web Map → Export 

 
Gambar 22 Tools Qgis2Web 

 
Gambar 23 Create Web Map 

 
Gambar 24 Export Web Map 

 
Gambar 25 Pilih Lokasi Penyimpanan 
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Gambar 26 Hasil Webgis Kelurahan Baratajaya Kota Surabaya 

4. KESIMPULAN 

WebGIS merupakan aplikasi Geographic Information System (GIS) yang dapat diakses secara online 

melalui internet / web. Pada konfigurasi WebGIS ada server yang berfungsi sebagai MapServer yang 

bertugas memproses permintaan peta dari client dan kemudian mengirimkannya kembali ke client. Dalam hal 

ini pengguna / client tidak perlu mempunyai software GIS, hanya menggunakan internet browser seperti 

Internet Explorer, Mozilla Fire Fox, atau Google Chrome untuk mengakses informasi GIS yang ada di server.  

GIS memiliki kemampuan untuk melakukan pengolahan data dan melakukan operasi-operasi tertentu 

dengan menampilkan dan menganalisa data. Aplikasi GIS saat ini tumbuh tidak hanya secara jumlah 

applikasi namun juga bertambah dari jenis keragaman applikasinya. Pengembangan applikasi GIS 

kedepannya mengarah kepada applikasi berbasis Web yang dikenal dengan Web GIS. Hal ini disebabkan 

karena pengembangan applikasi di lingkungan jaringan telah menunjukan potensi yang besar dalam 

kaitannya dengan geo informasi. Sebagai contoh adalah adanya peta online sebuah kota dimana pengguna 

dapat dengan mudah mencari lokasi yang diinginkan secara online melalui jaringan intranet/internet tanpa 

mengenal batas geografi penggunanya. Secara umum Sistem Informasi Geografis dikembangkan berdasarkan 

pada prinsip input/masukan data, managemen, analisis dan representasi data. Berikut merupakan tujuan 

Aplikasi WebGIS dalam penelitian ini adalah sebagai berikut : 

1. Mengembangkan peta digital berbasis WebGis untuk memudahkan pencarian data dan Peta dasar 

Kelurahan Baratajaya Kota Surabaya Seperti Penggunaan Lahan, Batas Administrasi Kelurahan, 

Jaringan Jalan, Jaringan Sungai, dan Permukiman. 

2. Memutakhirkan data dan menyusun mekanismenya yang bisa diterapkan. 

Dengan pembuatan Webgis Kelurahan Baratajaya Kota Surabaya ini diharapkan mampu menjadi 

percontohan untuk mempromosikan sebuah kota atau wilayah dari segi perencanaan dan keunikan yang 

dimiliki dari sebuah kota dan tempat tersebut. 
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